Disclaimer

This user manual is provided as a free service by FixYourDLP.com. FixYourDLP is in no way responsible for the content of this manual, nor do we guarantee its accuracy. FixYourDLP does not make any claim of copyright and all copyrights remain the property of their respective owners.

About FixYourDLP.com
FixYourDLP.com (http://www.fixyourdlp.com) is the World’s #1 resource for media product news, reviews, do-it-yourself guides, and manuals.

Informational Blog:  http://www.fixyourdlp.com
Video Guides:  http://www.fixyourdlp.com/guides
User Forums:  http://www.fixyourdlp.com/forum

FixYourDLP’s Fight Against Counterfeit Lamps:
http://www.fixyourdlp.com/counterfeits

Sponsors:

RecycleYourLamp.org – Free lamp recycling services for used lamps:
http://www.recycleyourlamp.org

Lamp Research - The trusted 3rd party lamp research company:
http://www.lampresearch.com

Discount-Merchant.com – The worlds largest lamp distributor:
http://www.discount-merchant.com
DATA PROJECTOR
U7-137SF
U7-132SF/U7-132hSF

User’s Manual

IMPORTANT

* DLPTM (Digital Light Processing) and DMD (Digital Micromirror Device) are registered trademarks of Texas Instruments Incorporated (U.S.A.).
* PC/AT, VGA and XGA are trademarks or registered trademarks of International Business Machines Corporation (U.S.A.).
* S-VGA is a registered trademark of Video Electronics Standards Association.
* Microsoft, Windows, and PowerPoint are registered trademarks of Microsoft Corporation (U.S.A. and other countries).
* Macintosh is a trademark of Apple Computer Inc. (U.S.A.).
* TMDS is a trademark of Silicon Image, Inc.

Note that even in the absence of explanatory notes, serious attention is paid to the trademarks of the various companies and to the product trademarks.
IMPORTANT SAFETY INFORMATION

Precautions
Please read this manual carefully before using your PLUS Data Projector and keep the manual handy for future reference.

These operating instructions apply to both models U7-132SF, U7-132hSF and U7-137SF.
The two models have the same display resolution and projection distance, but their CompactFlash (CF) card, wireless LAN card and wired LAN functions differ.
For details, refer to the table below.

These instructions describe the U7-137SF (full-function model).

<table>
<thead>
<tr>
<th>Model Name</th>
<th>CF card/Wireless LAN card function</th>
<th>Wired LAN function</th>
<th>USB memory function</th>
</tr>
</thead>
<tbody>
<tr>
<td>U7-137SF</td>
<td>L50107</td>
<td>L50107</td>
<td>L50107</td>
</tr>
<tr>
<td>U7-132SF</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>U7-132hSF</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

Explanations that do not apply to both models are marked **U7-137SF only**.

**CAUTION**

TO PREVENT SHOCK, DO NOT OPEN THE CABINET. NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED PLUS SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may have sufficient magnitude to cause electric shock. Therefore, it is dangerous to make any kind of contact with any part inside of this unit.

This symbol alerts the user that important literature concerning the operation and maintenance of this unit has been included. Therefore, it should be read carefully in order to avoid any problems.

The above cautions are given on the bottom of the product.

**WARNING**

TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE. DO NOT USE THIS UNIT’S GROUNDED PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THREE PRONGS CAN BE FULLY INSERTED. DO NOT OPEN THE CABINET. THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE. ALL SERVICING MUST BE DONE BY QUALIFIED PLUS SERVICE PERSONNEL.

This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

**RF Interference**

**WARNING**

The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those specified by PLUS Vision Corp. in this manual. Failure to comply with this government regulation could void your right to operate this equipment.

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

You are cautioned that changes or modifications not expressly approved by the party responsible for compliance could void your authority to operate the equipment.

**DOC Compliance Notice**

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Hg: Lamp in This Product Contains Mercury. Dispose of Lamp According to Local, State or Federal Law.
Important Safeguards
These safety instructions are to ensure the long life of the unit and to prevent fire and shock. Please read them carefully and heed all warnings.

Installation
- For best results, use the unit in a darkened room.
- Place the unit on a flat, level surface in a dry area away from dust and moisture.
- Do not place the unit in direct sunlight, near heaters or heat radiating appliances.
- Exposure to direct sunlight, smoke or steam can harm internal components.
- Handle the unit carefully. Dropping or jarring can damage internal components.
- Do not place heavy objects on top of the unit.

Power Supply
- The unit is designed to operate on a power supply of 100 - 240 V 50/60 Hz AC. Ensure that your power supply fits these requirements before attempting to use the unit.
- Handle the power cable carefully and avoid excessive bending. A damaged cord can cause electric shock or fire.
- Disconnect the power cable (main's lead) from the power outlet after using the unit. Before disconnecting the power cable, make sure that the STANDBY indicator lights in amber (not blinking or in green).

Cleaning
- Disconnect the power cable (main’s lead) from the unit.
- Clean the cabinet of the unit periodically with a damp cloth. If heavily soiled, use a mild detergent. Never use strong detergents or solvents such as alcohol or thinner.
- Use a blower or lens paper to clean the lens, and be careful not to scratch or mar the lens.
- Clean the ventilation slots and speaker grills on the unit periodically using a vacuum cleaner. If accumulated dust blocks the ventilation slots, the unit will overheat, which may cause the unit to malfunction. Use a soft brush attachment when using the vacuum cleaner. Do not use a hard attachment, such as a crevice tool, to prevent the damage to the unit.

Lamp Replacement
- Be sure to replace the lamp when the Status indicator comes on. If you continue to use the lamp after 2000 hours of usage, the lamp will turn off.

Fire and Shock Precautions
- Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the buildup of heat inside the unit. Allow at least 10 cm (3 inches) of space between the unit and walls.
- Prevent foreign objects such as paper clips and bits of paper from falling into the unit. Do not attempt to retrieve any objects that fell into the unit. Do not insert any metal objects such as a wire or screwdriver into the unit. If something should fall into the unit, immediately disconnect the power cable from the unit and have the object removed by a qualified PLUS service person.
- Do not place any liquids on top of the unit.

CAUTION – HOT!
The area around the exhaust vents is hot during and immediately after image projection. To avoid burns, keep your hands away from this area. Wait until the exhaust vents area cools off before touching it.

Do not look into the lens while the unit is on. Serious damage to your eyes could result.
**Major Features**

- **High brightness, lightweight projector with wireless/wired network presentation and PC-less presentation functions**
  The efficiency of the use of light is improved thanks to the combination of the DLP™ system and a unique optical design. The three primary colors necessary for expressing colors (red, green and blue) are produced with a single DMD (an ultra-high precision digital device), thereby achieving high brightness, compact size and light weight. In addition, wireless LAN technology is used to enable wireless presentations without connecting the projector to a computer with an RGB cable. The image viewer function can be used for presentations of PowerPoint files containing image files and animations that have been stored on CF memory cards or in the USB memory. (*1)
  
  *1. For details, refer to the "Image Viewer / Network" manual.

- **Short-focus zoom lens**
  This lens lets you project images onto a 60" screen from a distance of 1.85 meters, allowing you to use the projector even in small spaces and greatly expanding the usage possibilities.

- **Lamp replaceable without removing projector from ceiling**
  The lamp can be replaced from the top of the projector without removing the projector when it is mounted on the ceiling. This eliminates the need to take the projector down to replace the lamp, then to remount the projector and make the projection position adjustments, etc., as required with other projectors. (*2)
  
  *2. For details, see “Replacing the Lamp Cartridge” on page E-61.

- **Sharp, clear picture**
  The DLP™ display system affords RGB color fidelity and inconspicuous gaps between the individual dots, thereby permitting the display of small characters and diagrams with distinct clarity.

- **Advanced Color Wheel (ACW) allows for further enhancement of color reproduction**
  PLUS's unique ACW preserves brightness, while allowing for superlatively enhanced color reproduction and astoundingly clear picture quality attainable only with DLP™ technology.

- **High contrast ration of 2000:1**
  Use of a new generation of DMD devices has given birth to an amazing 2000:1 high contrast ratio. By widening the difference of brightness between black and white, you can see a degree of sharpness that is greater than just the brightness based on specifications.

- **Great moving image playback capabilities using the same principles as DLP Cinema™ technology**
  Plus DLP type projectors have the same makings as the DLP Cinema™ technology used in movie theaters. Because of their extremely fast response, even images with much movement – sports, movies – play smoothly without blurring.

- **Security lock function**
  The lock can be set so that a password must be input when the projector is started up. Without the correct password, no operations other than turning the power on and off can be performed. This function effectively protects the projector from unauthorized use.

- **Powerful functions for presentations**
  A wide variety of easy-to-set functions have been built into the projector, from a digital keystone correction function (used when making settings) that corrects picture distortion, to an auto adjustment function that automatically identifies the PC signal. There is also a built-in “Presentation Timer” function for further presentation convenience.

- **Beautiful reproduction of high-quality images from DVD**
  Faithful reproduction of color tones gives rise to the display of natural images. High-quality images such as those from DVD and digital high-definition television broadcasts bring out the display capabilities that are an essential strength of the DLP™ display system projector.

- **Enable RGB output in addition to digital/analog RGB input...**
  by using a DVI cable to connect the projector with a personal computer equipped with a DVI connector. This will allow fully digital pictures to be enjoyed.
  Also, by using the RGB output connector, the same image can be sent to the monitor of a personal computer.

- **Econo-mode switch function for the lamp output**
  Using the lamp Econo-mode will extend the life of the lamp and lower the power consumption. By switching the lamp mode to suit your operating environment, you will save on lamp cost as well as contribute to energy conservation and ecology.
# Table of Contents

## Preparation and Background Knowledge
- **IMPORTANT SAFETY INFORMATION** ................................................................. E-2
- **Major Features** ................................................................................................. E-4
- **Table of Contents** ............................................................................................ E-5
- **Checking the Supplied Accessories** ................................................................. E-7
- **Names of the Main Unit Parts** .......................................................................... E-9
- **Names of the Remote Control Parts** ................................................................. E-11
- **Inserting the Batteries** ..................................................................................... E-12
- **Remote Control Range** ................................................................................... E-12

## Setup and Projection
- **The Procedure Up to Projecting to the Screen** ................................................ E-13
- **Placement Guide** ............................................................................................. E-14
- **Connecting Personal Computers and Video Equipment** ............................... E-15
  - Personal Computers with a DVI Connector ..................................................... E-15
  - Personal Computers with a Mini D-Sub 15-Pin Connector ............................. E-16
  - To Output the External Output Signal of a Notebook Computer ...................... E-17
- **Connections with Composite Signals** ............................................................... E-18
- **Connections with S-VIDEO Connectors** ......................................................... E-18
- **Connections with Component Signals** ............................................................. E-19
- **Connections with Audio Connectors** ............................................................... E-20
- **Connections with the RGB OUT Connector** .................................................... E-21
- **Power Cable Connections and Switching the Power On/Off** .......................... E-22
  - **Operating** ....................................................................................................... E-22
  - **Finishing** ......................................................................................................... E-24
- **Adjustment of the Projection Screen** ............................................................... E-25
  - **Making Adjustments with the Adjusters** ....................................................... E-26

## General Operation
- **Input Selection** ............................................................................................... E-27
- **Automatic Adjustment of Analog RGB** ............................................................. E-27
- **Freezing a Moving Picture** ............................................................................... E-28
- **Cancelling Video and Audio Temporarily** ...................................................... E-28
- **Adjustment of the Volume** ............................................................................... E-28
- **Enlargement of the Image and Video Movement** .......................................... E-29
- **Using the Presentation Timer** ......................................................................... E-30
- **Using the Laser Pointer** .................................................................................. E-31
- **Performing Mouse Operations on the Computer with the Remote Control Unit** E-32
- **Controlling the Projector from a Computer** .................................................... E-33
- **Protecting the Projector with the Security Lock** .............................................. E-34
- **Using the Quick Menu** .................................................................................... E-36
# Table of Contents

## Menu Operations
- **Menu Operation Method** ................................................. E-37
- Names and Functions of Buttons Used for Menu Operations ................................................. E-37
- Menu Screen Names and Functions ................................................. E-38
- Performing Menu Operations ................................................. E-39
- Selecting Another Menu Name with Remote Control Operation ................................................. E-41
- List of Item Names Offering Input Selection and Adjustments/Settings ................................................. E-42

## Adjustments and Settings

### Image
- Brightness / Contrast / Color / Tint / Sharpness ................................................. E-44
- Picture Adj. / Fine Picture / H Position / V Position ................................................. E-44
- Reset ................................................. E-45

### Color
- Quick Color Adj. ................................................. E-46
- Gamma ................................................. E-46
- Color Temp. ................................................. E-47
- White ................................................. E-47
- Color Space ................................................. E-47
- White Balance ................................................. E-48

### View
- Aspect ................................................. E-49
- Filter ................................................. E-49
- Vertical Flip / Horizontal Flip ................................................. E-50
- Keystone ................................................. E-50
- Keystone Save ................................................. E-50

### Setup
- Auto Source ................................................. E-51
- Auto Power Off ................................................. E-51
- Menu Position ................................................. E-51
- Lamp Mode ................................................. E-52
- Input Format ................................................. E-52
- Presentation Timer ................................................. E-53

### Option
- Language ................................................. E-54
- On Screen ................................................. E-54
- Background ................................................. E-54
- Startup Screen ................................................. E-55
- Security Lock ................................................. E-55
- Network Password ................................................. E-55

### Info.
- Status ................................................. E-56
- Factory Default ................................................. E-56
- Lamp Timer Reset ................................................. E-56
- Resolution / Frequency ................................................. E-57
- Lamp Timer ................................................. E-57

## Miscellaneous
- When an Indicator is Lit or Blinking ................................................. E-58

## Troubleshooting
- E-59

## Cleaning
- Replacing the Lamp Cartridge ................................................. E-60

## Specifications
- E-61
- Table of Supported Frequencies ................................................. E-65
- Cabinet Dimensions ................................................. E-66
Checking the Supplied Accessories

Remove the main unit and the accessories from the box and check that the following items are included.

**Wireless remote control unit with laser pointer [1] / Size AAA batteries [2]**
This controls the projector. (See Page E-11.)

**Power cable (1.8 m / 5.9 feet) [1]**
This power cable supplies power to the unit. See Page E-22 about connections.

**DVI/Mini D-Sub 15-pin conversion adapter (18 cm / 0.59 feet) [1]**
This is used when the monitor connector of the personal computer is a mini D-sub 15-pin connector. See Page E-16, 19 about connections.
No. 772708000

**RGB signal cable (Mini D-sub 15-pin, 2 m / 6.6 feet) [1]**
This is used in making connections with a personal computer.
See Page E-16 about connections.
No. 773711000

**Video cable (RCA pin plug, 2 m / 6.6 feet) [1]**
This cable is used in the connection of video equipment that has a video connector. Connections are described on Page E-18.
No. 771703000

**S-Video cable (Mini DIN 4-pin plug, 2 m / 6.6 feet) [1]**
This cable is used in the connection of video equipment that has an S-video connector. Connections are described on Page E-18.
No. 771709000

**Audio cable (Mini plug, 2 m / 6.6 feet) [1]**
This cable is used with equipment that has phono type audio jacks. Connections are described on Page E-20.
No. 769710000

**D-sub conversion adapter (Mini plug / RCA pin plug, 18 cm / 0.5 feet) [1]**
This cable is used with equipment whose audio connector is of the phono pin type. Connections are described on Page E-20.
No. 771704000

**S-Video cable (Mini DIN 4-pin plug, 2 m / 6.6 feet) [1]**
This cable is used in the connection of video equipment that has an S-video connector. Connections are described on Page E-18.
No. 771709000

**Audio cable (Mini plug, 2 m / 6.6 feet) [1]**
This cable is used with equipment that has phono type audio jacks. Connections are described on Page E-20.
No. 769710000

**D-sub conversion adapter (Mini plug / RCA pin plug, 18 cm / 0.5 feet) [1]**
This cable is used with equipment whose audio connector is of the phono pin type. Connections are described on Page E-20.
No. 771704000
Checking the Supplied Accessories

USB cable (type A, 2 m / 6.6 feet) [1]
Used to perform mouse operations on a computer using the projector's remote control unit. Connections are described on Page E-32.
No. 781807800

Wireless LAN card [1] U7-137SF only

Storage case (for projector and accessories) [1]
This is a case designed for storing the projector and its accessories. Use this carrying case when storing or moving the projector.

Security sheet [1]
Security label [1]

Terminal cover cord [2]
When suspending from the ceiling, to prevent the terminal cover from falling, fasten the terminal cover to the projector using the included terminal cover cord as shown on the diagram.

“WARNING”
Handling the cables supplied with this product, will expose you to lead, a chemical known to the State of California to cause birth defects or other reproductive harm. Wash hands after handling.
Names of the Main Unit Parts

- Terminal cover
- Lamp cover [E-62]
- Zoom ring [E-25]
- Remote control sensor [E-12]
- Focus ring [E-26]
- Lens
- Lens cap
- Remove before use. Attach the lens cap after use to protect the lens.
- Exhaust vents
- Front adjuster button [E-26]
- (There is also one on the right side.)
- Focus ring [E-26]
- Lens cap
- Built-in Security Slot
- This security slot supports the MicroSaver Security System manufactured by Kensington Microware Inc.
- Built-in security slot
- (See description below.)
- Ventilation slots
- Rear adjuster [E-26]
- Front adjusters [E-26]
- Built-in security slot
- (See description below.)

FixYourDLPS.com
Discount-Merchant.com (800) 281-8860
THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES
Names of the Main Unit Parts

- **DVI**
- **AUDIO**
- **VIDEO**
- **S-VIDEO**
- **CR CARD**
- **100 BASE-TX**
- **10 BASE-T**
- **PC**
- **CONTROL**
- **MOUSE**
- **STATUS**
- **STANDBY**
- **AUTO**
- **SOURCE**
- **MENU**
- **QUICK MENU**

Buttons used in menu and quick menu operations:
- **SELECT (верху) buttons**
- **SOURCE button [E-27]**
- **MENU button [E-37]**
- **ENTER button [E-23]**
- **STANDBY button [E-22]**
- **AUTO button [E-27]**
- **STANDBY button [E-22]**
- **QUICK MENU button [E-36]**
- **SELECT (горизонтально) buttons**

**ิ**

- **RGB OUT connector [E-21]**
- **RGB IN connector [E-15, 16]**
- **PC CONTROL connector (DIN 9-pin) [E-33]**
- **DVI connector [E-15, 16, 19]**
- **S-VIDEO connector [E-18]**
- **VIDEO connector [E-18]**
- **AUDIO connector [E-20]**
- **CF card slot**
- **LAN connector**
- **USB connector**

**ิ**

- **Ventilation slots**
- **Speaker**
- **Remote control sensor [E-12]**
- **AC IN connector [E-22]**

Used when using a CompactFlash card or a wireless LAN card.

(See pages 15 and 16 on the "Image Viewer / Network" manual)
Names of the Remote Control Parts

Precautions

Handling of the Remote Control
* Do not drop the remote control or handle it inappropriately.
* Do not expose the remote control to water or other liquids. Should the remote control become wet, wipe it dry immediately.
* Try to avoid use in hot and/or humid locations.
* Remove the battery from the remote control when it is not going to be used for a long period.
* Some operations (such as menu operations) are available only through the use of the remote control and attention should be given to its careful handling.

Names of Parts the Remote Control Unit Included with the U7-132SF, U7-132hSF and U7-137SF

Infrared transmitter [E-12]
Laser transmitter [E-31]
L-CLICK button [E-32]

STANDBY button [E-22, 24]
This button is used to switch ON the power and set the unit to the STANDBY mode.

Buttons used for input selection [E-27]
RGB button and VIDEO button (VIDEO / S-VIDEO)

Buttons used for menu operations [E-39]
The , , , and buttons are the select ( , , , and ) buttons.

FREEZE button [E-28]
(Freezes moving pictures)

VOL button [E-28]
(Volume adjustment)

Number buttons [E-34]
(Used for the security lock.)

LASER button [E-31]
(Turns the laser point on and off)

AUTO button [E-27]
(Automatic adjustment of the RGB moving image)

QUICK button [E-36]
(Displays a simplified menu)

Buttons used for the PC mouse function [E-32]
(JOG button and R-CLICK button)

TIMER button [E-30]
(Presentation timer time setting display)

MUTE button [E-28]
(Temporarily cancels the video and audio)

ZOOM button [E-29]
(Digital zoom adjustment)

Note:
If a button on the remote control unit is held in continuously for approximately 30 seconds, signal transfer will be suspended. To resume transferring signals, press the button again.
Also, to use the jog button after signal transfer has been suspended, first press any other button, then press the jog button.

Fix Your DLP.com (800) 281-8860
THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES
Preparing the Remote Control

Inserting the Batteries

When using the remote control for the first time, install the batteries that were supplied.

1. Slide the battery compartment cover (located on the bottom of the remote control) and pull off.
2. Insert the batteries to match the “+” and “−” as indicated inside the compartment.
3. (A) Leaving a little space in the front, close the lid, (B) then with the back pressed tightly, (C) press the lid towards the front.

CAUTION
When replacing batteries, purchase two of the same type of AAA battery. Heed the regulations in effect in your region on the disposal of spent batteries.

Remote Control Range

Point the infrared transmitter of the remote control toward the remote control sensor located at the front or rear of the main unit and operate. Reception of the remote control signal should generally be possible within the range illustrated below.

Top View

<table>
<thead>
<tr>
<th>Angle</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>40°</td>
<td>5m / 16.4 feet</td>
</tr>
<tr>
<td>50°</td>
<td>7m / 16.4 feet</td>
</tr>
</tbody>
</table>

Side View

<table>
<thead>
<tr>
<th>Angle</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>40°</td>
<td>5m / 16.4 feet</td>
</tr>
<tr>
<td>50°</td>
<td>7m / 16.4 feet</td>
</tr>
</tbody>
</table>

Note
* Exposure of the main unit’s remote control sensor or the remote control infrared transmitter to bright light or the obstruction of the signal by an obstacle located in the pathway may prevent operation.
* The remote control will not function when the battery is exhausted.
The Procedure Up to Projecting to the Screen

Perform setup adjustments in the following order.

1 **Position the projector**
   Determine the locations to set up the screen and the projector.

2 **Connect the video equipment and personal computer**
   Connect your equipment to the projector.
   When making connections with the personal computer’s DVI connector or RGB connector, see “Connections with Personal Computers” on Page E-15.
   When making connections with the video equipment’s video connector or an S-video connector, see “Connections with Composite Signals” on Page E-18.
   When making connections with the video equipment’s YCbCr connector or YPbPr connector, see “Connections with Component Signals” on Page E-19.
   When playing the audio through the built-in speaker of the projector, see “Connections with Audio Connectors” on Page E-20.
   Monitoring the analog RGB input signal, see “Connections with the RGB OUT Connector” on Page E-21.

3 **Opening the lens shutter or lens cap**

4 **Connecting the power cable and switching on the power**
   See “Operating” on Page E-22.

5 **When selecting the language of menu displays, etc.**
   (Only when the power is first switched on following purchase)

6 **Switching on the power of the personal computer and video equipment**

7 **Properly adjust the projection image to the screen**
   See “Adjustment of the Projection Screen” on Page E-25.

8 **Selecting input equipment**
   See “Input Selection” on Page E-27.

9 **Adjust the screen or video image**
   Adjust the image to the optimum condition as required.
   See the Table of Contents for the adjustment items.

---

**About DLP projectors**

Though careful attention is paid to providing optimum quality, please note that with DLP type projectors, in rare cases there may be black spots or bright spots among the picture elements.

**Note:**
- Please purchase a screen.
- A DVI-D cable (order code 28-697), which is available separately, is required for connections with the DVI connector of the personal computer.
- A component cable (order code 28-690), which is available separately, is required to connect a DVD player or other equipment with YCbCr connectors.
- A component cable (order code 28-690), which is available separately, is required to connect high definition (HD) video equipment or other equipment with YPbPr connectors.
Use this information as a guide to find out about the screen size when the projector is placed at a certain location, or to find out the approximate size of a screen that will be required.

The projection distance over which focusing is adjustable is 1.20 m (3.9 feet) to 11.02 m (36.15 feet). The projector should be placed within this range.

When suspending the projector from the ceiling, change the projection method. See “Vertical Flip / Horizontal Flip” on E-50.

* There is a tolerance of ±5% due to design values.
* This table uses the lens apex and lens center as references and requires that the projector be in a horizontal condition (with front and rear adjusters fully withdrawn).

Screen Size and Projection Distance

- Placement Guide
- Use this information as a guide to find out about the screen size when the projector is placed at a certain location, or to find out the approximate size of a screen that will be required.
- The projection distance over which focusing is adjustable is 1.20 m (3.9 feet) to 11.02 m (36.15 feet). The projector should be placed within this range.
- When suspending the projector from the ceiling, change the projection method. See “Vertical Flip / Horizontal Flip” on E-50.

* There is a tolerance of ±5% due to design values.
* This table uses the lens apex and lens center as references and requires that the projector be in a horizontal condition (with front and rear adjusters fully withdrawn).
Connecting this unit with a personal computer permits presentation data to be projected as a large screen display at conferences, lectures, and on other occasions. Furthermore, connecting this unit to a DVD player or other video equipment source in combination with an audio/video amplifier and speaker system will allow you to enjoy convincing home theater.

**Connections with Personal Computer**

Please check the following before making connections with the personal computer.

- A suitable resolution for the U7-132SF/U7-132hSF/U7-137SF is 1024×768 dots (XGA) and the maximum displayable resolution is 1280×1024 dots (S-XGA).

Make changes to a displayable resolution at the personal computer side. Please check with “Table of Supported Frequency” on Page E-65.

- The setting method for the personal computer will differ depending on the specific model. Please read the personal computer instruction manual or the on-line help information, or contact the manufacturer of your personal computer.

- Projection might not be possible when connection is with a personal computer that is equipped with a DVI-I connector such as some PowerBook G4 computers and others when the signal is converted to analog RGB (which uses a mini D-sub 15-pin connector) and connection is made with the pertinent equipment. In circumstances such as this, please purchase separately a DVI-D cable and use the unit through the DVI connection.

Note that connections via DVI will enable the projection of a high quality image compared to connections using analog RGB.

**Personal Computers with a DVI Connector**

- Make the connection with a DVI-D cable and the PC connector of the projector.

When connecting, arrange the connectors in the proper orientation and plug in. Turn the screw knobs and fasten to the connector of the main unit.

- The projector has been set to “Auto” at the factory; however, if it does not project, please change the input setting to “Digital” using the menu sequence of [Setup] → [Input Format] → [DVI].


---

**Note**

- This projector uses a 29-pin DVI connector that supports the digital interface. Digital signal TMDS (Transition Minimized Differential Signalling) of the DVI (Digital Visual Interface) standard is used.

- The U7-132SF/U7-132hSF/U7-137SF is not HDCP compatible.
Connecting Personal Computers and Video Equipment

**Personal Computers with a Mini D-Sub 15-Pin Connector**

- When connections are made to the RGB connector of this projector, make these connections using the supplied RGB signal cable.
  
  Please orient the connector to mate properly when before inserting it, then turn the screw knobs to secure the connector to that of the projector.

  The projector has been set to “Auto” at the factory; however, if it does not project, please change the input setting to “RGB” using the menu sequence of [Setup] → [Input Format] → [RGB].


- When making connections with the DVI connector of the projector, please make the connection via the supplied DVI/mini D-Sub 15-pin conversion adapter.

  The projector has been set to “Auto” at the factory; however, if it does not project, please change the input setting to “RGB” using the menu sequence of [Setup] → [Input Format] → [DVI].


---

**Note:**

* Before making connections, check the power of the projector and the equipment to be connected is switched off.

* When projection will be with a notebook computer connected, knowledge will be required for the cable connection and notebook computer startup procedure as well as the operation that follows startup. Please consult the instruction manual of your notebook computer or the online help.

* To make wireless LAN connections with a computer or to use a viewer card, refer to the “Image Viewer / Network” manual. **U7-137SF only**
Connecting Personal Computers and Video Equipment

To Output the External Output Signal of a Notebook Computer

When projection will be with a notebook computer connected, knowledge will be required for the cable connection and notebook computer startup procedure as well as the operation that follows notebook startup. Please consult the instruction manual of your notebook computer or the on-line help while performing the following procedure.

1 Check whether a signal is being sent from the notebook computer to the projector. An indication appearing on the liquid crystal display of the notebook computer does not necessarily mean that an external output signal is being output.

2 Should a sign not be output from the notebook computer, please try the operation described below. For an IBM PC/AT, DOS/V computer, press the [Fn] key plus any one of the [F1] to [F10] keys. (See the table below.)

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Model</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>DELL</td>
<td>All computers</td>
<td>Fn + F8</td>
</tr>
<tr>
<td>EPSON</td>
<td>All computers</td>
<td>Fn + F8</td>
</tr>
<tr>
<td>FUJITSU</td>
<td>All computers</td>
<td>Fn + F10</td>
</tr>
<tr>
<td>iiyama</td>
<td>All computers</td>
<td>Fn + F3</td>
</tr>
<tr>
<td>IBM</td>
<td>All computers</td>
<td>Fn + F7</td>
</tr>
<tr>
<td>NEC</td>
<td>All computers</td>
<td>Fn + F3</td>
</tr>
<tr>
<td>Panasonic</td>
<td>All computers</td>
<td>Fn + F3</td>
</tr>
<tr>
<td>SHARP</td>
<td>All computers</td>
<td>Fn + F5</td>
</tr>
<tr>
<td>SONY</td>
<td>All computers</td>
<td>Fn + F7</td>
</tr>
<tr>
<td>SOTEC</td>
<td>All computers</td>
<td>Fn + F3–F5</td>
</tr>
<tr>
<td>TOSHIBA</td>
<td>All computers</td>
<td>Fn + F5</td>
</tr>
<tr>
<td>Victor</td>
<td>All computers</td>
<td>Fn + F10</td>
</tr>
</tbody>
</table>

Note: Table information is current to December 2003.

Note
When the liquid crystal display of the notebook computer and the projector are displayed at the same time, the projected image might not be correct even though the liquid crystal display shows a correct indication. Should this occur, stop the simultaneous display of the notebook computer and try the mode with external output only. (Try an operation such as that described in aforementioned Step 2 and try closing the liquid crystal panel which might result in external output only.)
Connecting Personal Computers and Video Equipment

**Connections with Composite Signals**

**Video Equipment with VIDEO Connectors**
- Make the connection to the VIDEO connector of the projector using the supplied Video cable.
- The input setting of the VIDEO connector has been set to “Auto” at the factory; however, if the projector does not project, please change the input setting to “Your Country’s Television Broadcast System” using the menu sequence of [Setup] → [Input Format] → [Video].

**Video Equipment with S-VIDEO Connectors**
- Make the connection to the S-VIDEO connector of the projector using the supplied S-video cable.
- The input setting of the S-VIDEO connector has been set to “Auto” at the factory; however, if the projector does not project, please change the input setting to “Your Country’s Television Broadcast System” using the menu sequence of [Setup] → [Input format] → [S-Video].
Connecting Personal Computers and Video Equipment

Connections with Component Signals

When the Video Equipment Has a YCbCr Connector or YPbPr Connector

- When connecting the computer to the projector’s RGB connector, connect using a separately sold component cable.
- The projector has been set to “Auto” at the factory; however, if it does not project, please change the input setting to “Component” using the menu sequence of [Setup] → [Input Format] → [RGB].
- When making connections with the DVI connector of the projector, please make the connection via the supplied DVI/mini D-Sub 15-pin conversion adapter.
- The projector has been set to “Auto” at the factory; however, if it does not project, please change the input setting to “Component” using the menu sequence of [Setup] → [Input Format] → [DVI].
- This projector automatically distinguishes the YCbCr input signal and the YPbPr input signal and projects it. When projecting the YCbCr signal or YPbPr signal, if the color of the overall image strongly leans toward being greenish or another color, change the setting under the menu of [Color] → [Color Space].
  See “Color Space” on Page E-47.
- Press the RGB button for input selection using the remote control.

Connections with Component Signals

When the Video Equipment Has a YCbCr Connector or YPbPr Connector

- When connecting the computer to the projector’s RGB connector, connect using a separately sold component cable.
- The projector has been set to “Auto” at the factory; however, if it does not project, please change the input setting to “Component” using the menu sequence of [Setup] → [Input Format] → [RGB].
- When making connections with the DVI connector of the projector, please make the connection via the supplied DVI/mini D-Sub 15-pin conversion adapter.
- The projector has been set to “Auto” at the factory; however, if it does not project, please change the input setting to “Component” using the menu sequence of [Setup] → [Input Format] → [DVI].
- This projector automatically distinguishes the YCbCr input signal and the YPbPr input signal and projects it. When projecting the YCbCr signal or YPbPr signal, if the color of the overall image strongly leans toward being greenish or another color, change the setting under the menu of [Color] → [Color Space].
  See “Color Space” on Page E-47.
- Press the RGB button for input selection using the remote control.

Diagram of Connections with Component Signals

- Component cable (Available as an option)
  Order code: 28-690

- DVI/mini D-Sub 15-pin conversion adapter (Supplied item)

- DVI/mini D-Sub 15-pin conversion adapter (Supplied item)

- Component cable (Available as an option)
  Order code: 28-690

- Green
- Blue
- Red

- Green
- Blue
- Red

Projecting component signals

Please note that when inputting 480i or 576i signals using a separately sold component cable and viewing video images, depending on the connected device and the video source being projected, the picture may be disturbed or may not be projected properly. In such cases, it is possible to achieve a picture with no disturbance that is projected properly by either switching to 480p signals or connecting using an S-Video cable instead.

Note

In some rare cases, the picture may not be displayed, depending on the connected device.
Connections with Audio Connectors

* Make the connection to the projector’s AUDIO connector using the supplied audio cable. When the audio jack of the equipment that is to be connected is of the RCA phono type, make connection via the supplied audio conversion adapter.
* The built-in speaker of the projector provides monaural audio. To enjoy convincing audio reproduction, please connect the audio output of the video equipment to your audio system.
* The built-in speaker outputs the audio of the equipment connected to the AUDIO connector.
Connections with the RGB OUT Connector

- The image from the computer connected to the DVI or RGB IN connector is output.
- The image of the connector selected with the input selection function is output.
- If an input other than DVI or RGB is selected with the input selection function, the output does not switch.
- While controlling the personal computer in front of you, the same screen can be projected with the projector. This allows personal computer control even from a position at which the projector image cannot be viewed.
There is an order in which the power cable is connected and the power is switched on/off.

Operating

1. Connect the AC IN connector of the projector and the power outlet using the supplied power cable. The STANDBY indicator will light in amber, and the unit will enter the standby mode.

2. Switch on the projector power
   Press the STANDBY button.

The first time the power is switched on after purchase, [Menu Language Select] will be displayed. See Page E-23 for information about language selection.
- When the power is switched on, the STANDBY indicator changes to blinking green, then lights steadily after about 60 seconds and the projection screen is set to the brightness of normal mode. At this time, if the STATUS indicator is lit in green, [Lamp Mode] is set to “Eco”. See Page E-52 for information about the selection method.

If the “Password” input window is displayed: See Page E-35.
A password is set for this projector.
The projector cannot be used unless the correct password is input.
To turn off the power: See Page E-24.
The projector is now capable of regular projection.

3. Switch on the power of the connected equipment

Note:
- When the power plug will be unplugged from the power outlet, please place the projector near the power outlet so that it may be reached easily.
- Press the STANDBY button after the STANDBY indicator is lit in amber.
- The included power cable is exclusively for use with the U7-132SF/U7-132hSF/U7-137SF. Never use it with other products.
When [Menu Language Select] is Displayed Upon Switching On the Power

The first time the power is switched on after purchase, [Menu Language Select] will be displayed. Follow the procedure described below and select the display language of the projector. If the image is blurred, turn the focus ring counterclockwise or clockwise to focus it. See Page E-26.

1. Press the SELECT (▲▼) buttons and align the deep blue cursor with [English].

![Cursor](cursor.png)

(button on main unit)

2. Press the ENTER button to set.
This will set the language and [Menu Language Select] will close.

![Cursor](cursor.png)

(button on main unit)

This completes the selection of the display language.

**Caution:**
[Menu Language Select] will not appear the next time the power is switched on. Should a change of language become necessary, see “Language” on Page E-54.
Power Cable Connections and Switching the Power On/Off

Finishing

1 Switch off the power of the connected equipment

2 Switch off the power of the projector
   Press the STANDBY button.

The [Power Off] display appears.
When the level gauge reaches maximum, the projection screen will go off (in about 5 seconds) and the projector will enter the power-off operation.

**Note**
* The operation can be cancelled by pressing a button other than the STANDBY button.
* One more press of the STANDBY button will switch off the power.

The STANDBY indicator changes to blinking amber and lights a steady amber after about 90 seconds (when the unit enters the standby mode).

3 Unplug the power cable
   Check that the STANDBY indicator is lit in amber and then unplug the power cable.
The STANDBY indicator will go off when the power cable is unplugged.

**Warning**
Do not unplug the power cable while the STANDBY indicator is blinking amber. Doing so may shorten the life of the lamp or damage the projector.
Adjustment of the Projection Screen

Switch on the power of the connected equipment and make the adjustments with the video signal being input to the projector.

Adjustment of the Projection Screen

1. **Turn the zoom ring to adjust the screen size of the projection image.**
   - Adjust the image to match the desired screen size. When outside of the adjustment range, move the projector to the rear or forward.

2. **Adjust the projection image to the screen.**
   - Check that the screen is set level and vertically.
   - (1) If the image is shifted to the left or right, move the main unit horizontally. (Align the center of the screen and the center of the projector lens.)
   - (2) If the image is shifted vertically, move the image up or down with the adjuster. See “Making Adjustments with the Adjusters” on Page E-26.
   - (3) If the image is slanted, adjust by turning the right or left front adjuster. See “Making Adjustments with the Adjusters” on Page E-26.
   - (4) A projection image such as that illustrated in the diagram is the result of the projector not being perpendicular to the screen. Set the projector so that it is pointing straight toward the screen.
   - (5) If the image shows keystone distortion, adjust using remote control or menu operations. See “Keystone” on Page E-50.

---

Discount-Merchant.com (800) 281-8860
THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES
3 Turn the focus ring and adjust the focus of the screen

Making Adjustments with the Adjusters

Raising the projection image
While viewing the projection image, (1) press and hold the front adjuster buttons located at the left and right and, (2) raise the projector to align the image with the screen, then release your fingers.

Turn the left and right front adjusters for fine adjustment. Adjust so that there is no shaking of the projector.

Lowering the projection image
Lower the front adjusters using the operation described above.

To lower the projection screen further, raise the rear adjuster. Fine adjustments are made by turning the left and right front adjusters. Make adjustments so that there is no rattling.

Note:
When the projector has a suspended or rear installation is used, the orientation of the projection will need to be changed. Please see “Vertical Flip/Horizotal Flip” on Page E-50.
General Operation

This section describes the use of direct operation with the main unit or remote control buttons. For information about operation using the menu, see “Menu Operation Method” on Page E-27 and the various items on Pages E-44 to E-57.

Input Selection

Select the input signal to be projected. Press the SOURCE button on the projector or the RGB or VIDEO button on the remote control unit. When one of the buttons is pressed, a menu for selecting the source appears. Use the SELECT ▲ and ▼ buttons or the SOURCE, RGB and VIDEO buttons to select the desired source, then press the ENTER button. When the “Auto Source” function is set to “On”, the input signals are searched for automatically in sequence, but the next input signal is not detected while the input signal selection menu is displayed.

**SOURCE button**
- DVI → RGB → Image Viewer → Network → Video → S-Video

**RGB button**
- DVI → RGB → Image Viewer → Network

**VIDEO button**
- Video → S-Video

**Note**
- * When you do not operate source selection, the projector will assume the input selection condition that was previously used.
- * See “Auto Source” on Page E-51 for information about the Auto Source on and off conditions.
- * When the input format has been switched, you may be required to reconnect the input signal.

Automatic Adjustment of Analog RGB

This procedure automatically adjusts the position, screen size, vertical stripes and colors of the analog RGB or DVI analog input signals being projected.

Normally, this function is adjusted automatically at the time of signal selection.

**Main unit operation/Remote control operation:** Press the AUTO button. (This will not function while the menu or the quick menu is displayed.)

A press of the AUTO button starts the automatic adjustment.

**Note**
- * If the display position is shifted, vertical lines appear on the picture, or the projection is not good even after using automatic adjustment, please perform image adjustment manually. See “Picture Adj. / Fine Picture / H Position / V Position” on Page E-44.
- * If the position is off or there are dark vertical bands on the picture, press the AUTO button a few times to make the screen as bright as possible (make the screen as bright as possible by for example displaying the trash window over the entire screen). If the problem persists after pressing the AUTO button several times, set manually at the “Picture Adjustment” menu.
- * When the image extends beyond the boundaries of the screen or is smaller than the screen, set Auto Source to “Off”. See “Auto Source” on Page E-49.
Freezing a Moving Picture

This function is used to stop and view a moving picture. Note that the input image continues to advance even though the picture there is a still picture condition.

A press of the FREEZE button changes the screen to a still picture. A further press returns the screen to a moving picture.

Cancelling Video and Audio Temporarily

This function is used to cancel the video and audio at the same time.

A press of the MUTE button will blank the picture and the sound, and the screen will take on the background color that has been set. Another press will cause a return to the original conditions.

Adjustment of the Volume

This function adjusts the volume of the built-in speaker.

1. Press the ▲ or ▼ VOL button to adjust the volume.
   The volume adjustment display appears when one of the buttons is pressed.

   ![Volume Adjustment Display](image)

   The ▲ button increases the volume and the ▼ button decreases the volume.

2. Press the CANCEL button to immediately close the display.
   The display will close when there has not been an operation in about 10 seconds.

Note:
* Adjustment of the volume will not produce any sound unless an image is being projected.
**Enlargement of the Image and Video Movement**

This function digitally enlarges the personal computer image and video image.

1. **Press the ZOOM button to enlarge the image.**
   - The zoom display appears when the ZOOM button is pressed.
   - When the button is pressed, the image is enlarged approximately 2 times, and when the button is pressed the image is reduced (returning to 1:1).
   - Images input from a Digital, Image Viewer or Network cannot be enlarged.

   ![No enlargement](image1.png) ![Approximately 2 times enlargement](image2.png)

2. **Pressing the SELECT buttons on the remote control at the time of the zoom operation will cause the display position to move.**
   - (There will not be any movement when zoom is at 0.)

   ![Approximately 2 times enlargement](image3.png) ![Movement](image4.png)

3. **Press the CANCEL button to immediately close the display.**
   - The display will close when there has not been an operation in about 10 seconds.

   ![CANCEL button](image5.png)

**Note:**
- After magnifying the image, be sure to use the ZOOM button to bring the gauge value back to “0”.

**The image can also be moved in the following circumstances.**

- When “Aspect” is set to “Real” by the signal of the Analog RGB or DVI analog, and the input resolution is higher than the display resolution of the projector.
- When “Aspect” is set to “Zoom” by the video signal.

**Note:**
- * Zoom and image movement functions are cancelled when the input is switched.
- * Movement of the screen will not be possible when the menu screen is being displayed.
General Operation

Using the Presentation Timer

The presentation is given while checking the timer displayed on the screen.
The gauge display allows the remaining time to be known at a glance.

1. Press the TIMER button to show the settings display.
The display will close when an operation has not been made for about 10 seconds.

   Presentation Timer ➤ Off ➤

   [Timer settings display]
   Press the CANCEL button to close the display immediately.

2. Use the ◀ and ▶ SELECT buttons to set the time.
The setting contents are “Off” and from 10 to 60 minutes (in 10-minute intervals)
Settings can also be made with the SELECT (◀ ▶) buttons.

   Presentation Timer ➤ 10 min. ➤

3. Press the ENTER button and start the timer.
   • The display of the timer setting will close, the display of the timer will appear and simultaneously the timer will start.

   [Timer Display]
   The blue gauge indicates the remaining time. When the gauge disappears, the time is up.
The gauge continues to be displayed when the timer is stopped.

   Gauge (Blue) When the remaining time is “0” (Gray)
   • Press the ENTER button to restart the timer. The timer will start with the same time setting.
   • Press the CANCEL button to close the timer display. The timer setting will return to “Off”.

Moving the Position of the Timer Display
The SELECT (▲▼◄►) buttons on the remote control permit movement within the movable range of the timer display.

Note:
* The timer display is not displayed when a menu or message is displayed or when the “Wireless Projector” setting screen is being projected, but the timer continues functioning. The timer display is also not displayed when no signals are being input.
* While the presentation timer is being displayed, screen movement will not be possible in the zoom mode.
* Timer key operations cannot be performed when the input is set to “Image Viewer”.

E-30
General Operation

Using the Laser Pointer

The remote control unit's laser pointer can be used to point to the section currently being explained, making presentations more effective.

CAUTION

Do not look at the laser pointer's light source. Be sure to heed the following. Pointing the laser beam at the eyes could lead to reduced vision or vision impairment.
• Never look at the laser pointer's light source.
• Do not point the laser beam at people.
• Do not let children use the laser pointer.

This label is located on the side of the remote control.

Operation

The red laser beam is emitted from the tip of the remote control unit while the LASER button is pressed in. Point the remote control unit's transmitter in the direction you want to indicate. The laser beam turns off when you release your finger from the LASER button.
Performing Mouse Operations on the Computer with the Remote Control Unit

When a computer and the projector are connected, mouse operations can be performed on the computer using the projector’s remote control unit. When projecting images from the computer, the projector can be operated and mouse operations on the computer performed with the same remote control unit, making for efficient presentations.

Connecting the computer and projector
Use the USB cable included with the projector to connect the computer’s USB (type A) connector to the projector’s MOUSE connector.

Note:
* Be sure to plug the cable in securely.
* Depending on the type of connection, the computer’s operating system, etc., it may be necessary to change settings or restart the computer after making the connections.

Functions of the mouse function buttons
When operating, point the remote control unit’s transmitter towards the remote control sensor on the projector.

L-CLICK button (on back)
Press this to perform the left-click operation.

JOG buttons
These move the computer’s pointer in the corresponding direction.

R-CLICK button
Press this to perform the right-click operation.

INFORMATION
The R-CLICK/CANCEL button is used for both the projector and mouse function. When the R-CLICK/CANCEL button is pressed while a menu is open, the menu is closed.

Note:
Connections with USB Cables
* For PC/AT compatible computers, this function cannot be used with operating systems other than Windows 98SE, Me, 2000 and XP. For Macintosh computers, this function cannot be used with operating systems other than OS 9 and later.
* When the cable is disconnected and then reconnected to the USB port of the personal computer or the MOUSE connector of the projector, allow at least 5 seconds before reconnecting. Do not repeatedly disconnect and reconnect the cable in a momentary fashion. The personal computer may not be able to correctly identify the projector as a result.
* The supplied USB cable is a dedicated cable for this projector. There is no guaranty that it will work in connections with other USB equipment.
* This function may not work with some computers.
**Controlling the Projector from a Computer**

Use the control connector if the projector cannot be operated with the remote control unit, for example when it is suspended from the ceiling.

**RS-232C connections**

Use the order-made cable (D-Sub 9-pin/DIN 9-pin) to connect the computer’s RS232C connector to the projector’s “PC CONTROL” connector.

**Order-made cable (D-Sub 9-pin/DIN 9-pin) pin assignment**

<table>
<thead>
<tr>
<th>CN-1 (DIN 9-pin side)</th>
<th>CN-2 (D-Sub 9-pin side)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (TXD)</td>
<td>3 (PC-TXD)</td>
</tr>
<tr>
<td>2</td>
<td>NC</td>
</tr>
<tr>
<td>3</td>
<td>NC</td>
</tr>
<tr>
<td>4 (GND)</td>
<td>5 (GND)</td>
</tr>
<tr>
<td>5</td>
<td>NC</td>
</tr>
<tr>
<td>6</td>
<td>NC</td>
</tr>
<tr>
<td>7 (RXD)</td>
<td>2 (PC-RXD)</td>
</tr>
<tr>
<td>8</td>
<td>NC</td>
</tr>
<tr>
<td>9</td>
<td>NC</td>
</tr>
</tbody>
</table>

**Connecting via a LAN U7-137SF only**

It is also possible to control the projector with Telnet connections via a LAN or wireless LAN (using PLUS projector control commands).

**Note:**

* This function may not work with some computers.
* Specialized knowledge is required to use the control connector. Consult a specialist, such as the person suspending the projector from the ceiling.
* Have the order-made cable made by a specialist with the required specialized knowledge based on the pin assignment shown above.
Protecting the Projector with the Security Lock

A password can be registered and the security lock set in order to protect the projector from unauthorized use.

Registering the password

The password is registered using the menus. For instructions on operating the menus, see “Menu Operation Method” on E-37.

1. Select “Security Lock” in the “Option” menu and set it to “Enable”.
   The menu closes and the password registration display appears.

2. Use the number buttons (1 to 4) to register the password.
   Be sure to input a 4-digit number.
   Example: Registering the password “2441”
   (1) Press number button “2”. An “*” (asterisk) appears at the first place.
   Next press number buttons “4”, “4” and “1” in that order. Asterisks appear in all four places.

   (2) Input the password again. An “*” appears when the input number matches. If there is a mistake, the asterisks turn off. Start over from step (1) above.
   If the password matches, the password registration display closes.

Note:
To cancel the number you have input, press the CANCEL button.
The asterisks disappear and the display returns to the input standby mode at the first place.
To cancel the password registration mode, press the CANCEL button again. The “Password” display turns off.

This completes password registration.
The “Password” input display appears the next time the power is turned on.

Note:
The numbers you have input are not displayed. Be sure to write down the password and store it in a safe place.
General Operation

If the password input display appears when the power is turned on
When a password has been registered, the “Password” input window appears on the projected image when the power is turned on. The projector continues projecting this image until the correct password is input. At this time, only the STANDBY button (power off) works. Use the procedure described below to input the registered password. For instructions on registering the password, see E-34.

Input the password using the number buttons (1 to 4).
Be sure to input the registered 4-digit number.

Example: To input the password “2441”
Press number button “2”. An “*” (asterisk) appears at the first place.

Next press number buttons “4”, “4” and “1” in that order. Asterisks appear in all four places.
If the password matches, the window turns off and the projector can be used normally.

Canceling the password/Changing the password
The password is canceled and changed using the menus. For instructions on operating the menus, see “Menu Operation Method” on E-37.

Canceling the password
Select “Security Lock” in the “Option” menu and set it to “Disable”.
This clears the password and disables the security lock.
The password input display no longer appears when the power is turned on.

Changing the password
After setting “Security Lock” to “Disable” as described above, set it back to “Enable”. The menu closes and the password registration display appears.
Register the new password. See “Registering the password” on E-34.

Protecting the network settings by password
The network settings can be protected by password. Refer to the “Image Viewer / Network” manual.
Using the Quick Menu

This function permits frequently used adjustments to be performed quickly.
Note that the Quick Menu will not be displayed unless the signal of the connected equipment is input. Please select the input that you wish to adjust.

Main unit operation
(1) Press the QUICK MENU button to display the quick adjustment display.
   Further presses cause the adjustment display to change in sequence.
   Press the SELECT ▲ or ▼ button to switch to the desired adjustment display.
(2) Press the SELECT ◀ or ▶ button to adjust.

Remote control operation
(1) A press of the QUICK MENU button brings up the quick adjustment display.
   Further presses cause the adjustment display to change in sequence.
   The adjustment display can be selected with use of either the SELECT ▲ or ▼ button.
(2) Press the cursor ◀ or ▶ button to make the adjustment.
(3) To close the display immediately, press the CANCEL button.
   In the absence of operations for a period of about 10 seconds, the display will close automatically.

Content of Adjustments and Settings

Example: Brightness adjustment display

<table>
<thead>
<tr>
<th>Display Item</th>
<th>Adjustment/Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>0</td>
</tr>
</tbody>
</table>

Brightness Adjusts the brightness of the image. See page E-44.
Contrast Adjusts the contrast of the image. See page E-44.
Keystone Corrects (vertical) keystone distortion of the screen. See page E-50.
Volume This function adjusts the volume of the built-in speaker. See page E-28.
Presentation timer Sets the time of the presentation timer. See page E-30.
Quick Color Adj. Select the preset color mode. See page E-46.
Menu Operation Method

- This section describes only the menu operation method. Please see this item should you need information while performing menu operations.
- For information about a menu function, adjustment, or setting, please see one of the pages containing such descriptions.
- Adjustments and settings are made by projecting an image and adjusting to an optimum condition.
- The remote control should be pointed toward the remote control sensor of the projector and operated.
- To return the various items that have been changed via the menu to their standard values (i.e., default values at time of shipping from the factory), see “Factory Default” on Page E-56. (Some items will not return to their initial values.)
- The adjustment/setting items and contents will differ depending on the input selection and the adjustment/setting items that can be used with the input signal are displayed on the menu.

Names and Functions of Buttons Used for Menu Operations

(Remote Control)

- **MENU button**
  Used for menu display and menu closure.

- **SELECT (▲▼➡️) buttons**
  Used in the selection of menu names and item names as well as in setting and adjusting the item contents.

- **CANCEL button**
  Used to return to menu name selection as well as to close the menu (and the sub menu display).

- **ENTER button**
  Used to set the verification display.

(Main Unit)

- **SELECT (▲▼➡️) buttons**
  Used to display menus, to return to menu name selections, and to close menus (i.e., closing sub menu displays).

- **MENU button**
  Used to display menus, to return to menu name selections, and to close menus (i.e., closing sub menu displays).
Menu Operation Method

Menu Screen Names and Functions

Menu Name
This is the title of the menu. There is a change to the title screen when the menu is selected. The cursor moves to the selected menu name.

Cursor (Deep Blue)
This permits setting/adjustment of the item located at the cursor position.

Item Name
This is the name of the adjustment or setting.

Adjustment Bar and Settings Contents
Adjustment Bar: The increases and decreases in bar length express the adjustment condition. Setting Contents: Displays the contents that have been set.

Adjustment Bar

Sub menu

Icon: Pressing the ENTER button displays the sub menu or setting contents.

FixYourDLP.com
Discount-Merchant.com (800) 281-8860
THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES
Menu Operation Method

Performing Menu Operations

• Only “Setup”, “Options” and “Info.” can be selected when no signal is being input.
• The menu display will close if, after pressing a button, the next button operation is not made within 30 seconds.
• The adjustment and the setting values are stored even when the power is switched off or the plug is disconnected from the power outlet.
  (Note that some items are not stored.)

Preparation

Switch on the power of the connected equipment, start the play operation or another operation, and input the signal to the projector.
Select the input that you wish to adjust.
The menu display of the description diagram depicts an example in which the “Keystone” item name is selected.

Menu Display

1 Press the MENU button to display the menu

The menu name that existed when the menu was closed previously will be displayed.

Selection of the Menu Name

2 Press the SELECT (◄►) button to select the menu name

Each press of the SELECT ► button advances the selection one step in the sequence of “Color” → “View” → “Setup” → “Option” → “Info” → “Image”. Each press of the SELECT ◄ button causes a return of one step.
The cursor moves to the selected menu name.

Note:
Please check that the cursor of the item name has disappeared at the time of menu name selection.
Press the CANCEL button to make the cursor disappear.
Displaying the Cursor

3 Press the \( \downarrow \) SELECT button to display the item name selection cursor.

Selection of the Item Name

4 Press the SELECT (\( \uparrow \),\( \downarrow \)) button to align the cursor with the item name

Items for which the \( \square \) Icon Is Displayed
Press the ENTER button to display the submenu.
Press the SELECT (\( \uparrow \),\( \downarrow \)) button and align the cursor with the desired item name.

There are also some items for which the setting display or the verification display will appear. Please see the various item descriptions.

Making Adjustments/Settings

5 Press the SELECT (\( \leftarrow \),\( \rightarrow \)) button and make the adjustment (or setting) while viewing the image
When a button is pressed, the image will also change.

Adjustment display: Each press of the button results in a change of 1 point and continued presses cause changes to proceed in order.
Setting display: The setting contents display changes with each press of the button.
Menu Operation Method

Closing the Menu

6 Press the MENU button and close the menu display

Selecting Another Menu Name with Remote Control Operation

When a sub menu is displayed, press the CANCEL button and close the sub menu. Press the CANCEL button again to turn off the item name cursor.

Press the SELECT (●) button and select the menu name. (Menu names cannot be selected when the item name cursor is displayed.)

Note:
A press of the QUICK button while the menu is displayed will close the menu and display the quick menu. A press of the MENU button while the quick menu is displayed will close the quick menu and display the menu.
The item names that can be adjusted/set will differ depending on the input signal.

* "Tint" can be adjusted only at the time of NTSC composite/S signal input.

* The color space can only be adjusted with high definition TVs.

* The “Real” setting under “Aspect” for digital RGB signals can only be adjusted when the input signal is of XGA size or smaller.
### Menu Operation Method

<table>
<thead>
<tr>
<th>Menu name</th>
<th>Item Name</th>
<th>Sub Menu Item Name</th>
<th>Input Terminal</th>
<th>DVI</th>
<th>RGB</th>
<th>Reference Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setup</strong></td>
<td>Auto Source</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-51</td>
</tr>
<tr>
<td></td>
<td>Auto Power Off</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-51</td>
</tr>
<tr>
<td></td>
<td>Menu Position</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-51</td>
</tr>
<tr>
<td></td>
<td>Lamp Mode</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-52</td>
</tr>
<tr>
<td></td>
<td>Input Format</td>
<td>DVI</td>
<td></td>
<td></td>
<td></td>
<td>E-52</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RGB</td>
<td></td>
<td></td>
<td></td>
<td>E-52</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S-Video</td>
<td></td>
<td></td>
<td></td>
<td>E-52</td>
</tr>
<tr>
<td></td>
<td>Presentation Timer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-53</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td>Language</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-54</td>
</tr>
<tr>
<td></td>
<td>On Screen</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-54</td>
</tr>
<tr>
<td></td>
<td>Background</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-54</td>
</tr>
<tr>
<td></td>
<td>Startup Screen</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-55</td>
</tr>
<tr>
<td></td>
<td>Security Lock</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-55</td>
</tr>
<tr>
<td></td>
<td>Network Password</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-55</td>
</tr>
<tr>
<td><strong>Info.</strong></td>
<td>Status</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-56</td>
</tr>
<tr>
<td></td>
<td>Lamp Timer Reset</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-56</td>
</tr>
<tr>
<td></td>
<td>Resolution</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-57</td>
</tr>
<tr>
<td></td>
<td>Frequency</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-57</td>
</tr>
<tr>
<td></td>
<td>Lamp Timer</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>E-57</td>
</tr>
</tbody>
</table>
• Perform this operation while projecting the picture for which the adjustment/setting will be made.
• Select the menu name “Image”.

See “Menu Operation Method” on Page E-37 for information about performing menu operations. The item name display will differ depending on the input signal. See “List of Item Names Offering Input Selection and Adjustments/Settings” on Page E-42.

### Brightness / Contrast / Color / Tint / Sharpness

Picture qualities such as brightness and contrast will change depending on whether the room is bright or dark. Please adjust to suit your preference.

Select the desired item name and then adjust with the SELECT ( mainScreen ) buttons.

<table>
<thead>
<tr>
<th>Item Name</th>
<th>SELECT 〈 Button</th>
<th>SELECT 〉 Button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brightness</td>
<td>Darker</td>
<td>Brighter</td>
</tr>
<tr>
<td>Contrast</td>
<td>Less contrast</td>
<td>More contrast</td>
</tr>
<tr>
<td>Color</td>
<td>Less dense color</td>
<td>Denser color</td>
</tr>
<tr>
<td>Tint</td>
<td>More red</td>
<td>More green</td>
</tr>
<tr>
<td>Sharpness</td>
<td>Softer image</td>
<td>Sharper image</td>
</tr>
</tbody>
</table>

**Note:**
* The adjustment values of the adjustable items are stored according to input source.
* “Tint” can only be adjusted when inputting NTSC composite/S-Video signals or component signals.

### Picture Adj. / Fine Picture / H Position / V Position

Usually, automatic adjustment is performed at the time of signal selection, but when automatic adjustment is not effective, these adjustments can be performed.

**Note:**
When the image extends beyond the boundaries of the screen or is smaller than the screen, check that the “View” → “Aspect” setting is set to “Auto”. See “Aspect” on Page E-49.

### Picture Adj. (Picture Adjustment)

Adjust this when bright and dark vertical bands appear on the screen.

Select the “Picture Adj.” item name and adjust with the SELECT ( mainScreen ) buttons so that the vertical bands disappear and brightness becomes uniform across the screen.
**Image**

**Fine Picture**
Adjust this when the picture shows a lack of color fidelity or flickering.

Select the “Fine Picture” item name and adjust with the SELECT (¶) buttons so that the lack of color fidelity or the flickering disappears.

**H Position**
Adjust this when the picture is shifted to the left or right.

Select the “H Position” item name and adjust with the SELECT (¶) buttons.

**V Position**
Adjust this when the picture is shifted up or down.

Select the “V Position” item name and adjust with the SELECT (¶) buttons.

**Reset**
This function resets (i.e., returns to the standard settings) the adjustment/setting value of the “Image” menu name.

A press of the ENTER button forces the reset.

**Note:**
- The item name “Fine Picture” at the time of RGB input will not be reset.
- “Reset” of the menu name “Image” can be reset for each input source.
- To reset the adjustments/Settings of all the menu items (while noting that there are some items that cannot be reset), see “Factory Default” on Page E-56.
Color

• Do the following operation while displaying the image you want to adjust or set.
• Select the menu name “Color”.

See “Menu Operation Method” on Page E-37 for information about performing menu operations. The item name display will differ depending on the input signal. See “List of Item Names Offering Input Selection and Adjustments/Settings” on Page E-42.

Quick Color Adj.

Select the preset color mode.

Select the “Quick Color Adj.” item name and select the setting contents with the SELECT (entifier) buttons.

Picture ........ Select this to prioritize color.
Standard ...... This is the standard selection. (Default setting)
Dynamic ..... Select this for prioritizing brightness.
* When “Picture”, “Standard” or “Dynamic” is selected, the “Gamma”, “Color Temp.” and “White” adjustment items are displayed in gray and cannot be selected or adjusted.
Custom ....... “Gamma”, “Color Temp.” and “White” adjustment items can be selected and adjusted
* The selected values for the different adjustment items are stored in the memory so the desired color adjustments can be set.

Gamma

Gamma corrects the proportion of change of the dark portions from the bright portions of the input signal.
Set this to reproduce natural color tone or to distinctly project a personal computer picture in a bright conference room.

Select the “Gamma” item name and select the setting contents with the SELECT (entifier) buttons.

Normal ....... Correction with standard settings
Natural ........ Corrects for natural color tones
Real ???????? Corrects with emphasis on brightness

Note:
When “Picture”, “Standard” or “Dynamic” is selected for “Quick Color Adj.”, the “Gamma” adjustment item is displayed in gray and cannot be selected or adjusted.
### Color Temp.

The screen color is affected by the color of the illumination and other extraneous light.

This function adjusts the white, which is the reference color for video equipment, and improves the quality of color reproduction. Adjustment can also be used to enhance skin colors.

Select the item name “Color Temp.” and select the setting contents with the SELECT (➡️) buttons.

- Low .......... Produces warm whites (reddish)
- Medium ...... Produces warm whites (yellowish)
- Normal ....... Produces the white of sunlight
- High .......... Produces cool whites (bluish)

**Note:**
When “Picture”, “Standard” or “Dynamic” is selected for “Quick Color Adj.”, the “Color Temp.” adjustment item is displayed in gray and cannot be selected or adjusted. See “Quick Color Adj.” on E-46.

### White

When projecting, this function is used to emphasize the whites of text or diagrams on the personal computer.

Select the item name “White” and use the SELECT (➡️) buttons to select the setting contents.

Select the desired degree of white from among “Low”, “Medium”, and “High”. 

**Note:**
When “Picture”, “Standard” or “Dynamic” is selected for “Quick Color Adj.”, the “White” adjustment item is displayed in gray and cannot be selected or adjusted. See “Quick Color Adj.” on E-46.

### Color Space

Set this function when a component signal (YPbPr) is projected and the image is extremely red or extremely green.

Select the item name “Color Space” and use the SELECT (➡️) buttons to select a color space setting that provides a normal image.

**Selection contents at the time of YPbPr input**
BT.709, SMPTE240

**Note:**
When the component signal undergoes conversion processing to red, green, and blue which express the image of the projector, the correct color cannot be reproduced unless a system compliant with the color difference conversion system of the input signal is used. Color Space serves to make this selection.

- The color space can only be adjusted with high-definition TVs.
The black and white levels of the analog RGB or DVI analog input signals being projected are adjusted automatically for the computer. This increases color reproducibility.

1. Select the item name [White Balance] and press the ENTER button. The display will change to [Input Black Signal].

2. The screen background color of the connected personal computer will be set to black.

3. Press the ENTER button. The display will change to [Adjusting Black] and the black level will be adjusted.

4. The adjustment of the black level is completed and the display changes to [Input White Signal].

5. The screen background color of the connected personal computer will be set to white.

6. Press the ENTER button. The display will change to [Adjusting White] and the white level will be adjusted.

[White balance complete] is displayed for a while and the adjustment is completed.
• Perform this operation while projecting the picture for which the adjustment/setting will be made.
• Select the menu name “View”.

See “Menu Operation Method” on Page E-37 for information about performing menu operations. The item name display will differ depending on the input signal. See “List of Item Names Offering Input Selection and Adjustments/Settings” on Page E-42.

Aspect

This function sets the horizontal and vertical picture proportions of the input signal.

Select the item name “Aspect” and select the setting contents with the SELECT (➡) buttons.

<table>
<thead>
<tr>
<th>Input Signal</th>
<th>Auto</th>
<th>Direct</th>
<th>Real</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspect ratio selection</td>
<td>4:3 screen</td>
<td>16:9 screen</td>
<td></td>
</tr>
<tr>
<td>The setting is higher than the display resolution of the projector.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The setting is lower than the display resolution of the projector.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Personal Computer Signal
Auto ............ Automatically enlarges or reduces the image to project a full screen in a ratio of 4:3
Direct .......... Maintains the aspect ratio and projects a picture of the maximum displayable size
Real ............ Projects the input signal without pixel conversion

Video Signals
Auto ............ While maintaining the aspect ratio, projects a full screen so that no portions extend beyond the boundaries of the screen. The top and bottom of the 16:9 image becomes black.
Wide ............ Projects to fill the full width with the entire image at 16:9. (This feature is used to project a squeezed image in a proper aspect ratio.)
Zoom ............ Projects only the 4:3 portion within 16:9 image to fill the screen. (Portion that extend off screen is cut.)

Note:
Please note that using this monitor for the purpose of commercial gain or the attraction of public attention in a venue such as a coffee shop or hotel and projecting a 4:3 screen in wide mode or leaving a squeezed screen as a compressed image raises concern about the infringement of the copyright holder’s rights which are protected by copyright law.

Note:
• When selection has been made for the “Real” setting of the personal computer signal (i.e., when the input signal and the projector display resolution are high) and the “Zoom” setting of the video signal, pressing the SELECT (▼ ▲ □ □ □) buttons on the remote control will permit movement of the display position. Note that there will not be any movement when the menu or the quick menu is displayed.
• The “Real” setting under “Aspect” for digital RGB signals can only be adjusted when the input signal is of XGA size or smaller.

Filter

This function sets the sharpness when the input signal is adjusted to the resolution of the projector and enlarged or reduced.

Select the item name “Filter” and select the setting contents with the SELECT (➡) buttons.

Smaller numerical values result in a sharper picture and larger values result in a softer picture. Please select your desired setting value.
**Vertical Flip / Horizontal Flip**

This is the selection of how images are projected on the screen. Set this when the projector is suspended from the ceiling, installed on its back, etc.

Select the item name “Vertical Flip” or “Horizontal Flip” and select the setting contents with the SELECT (◀▶) buttons.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Horizontal Flip” Off</td>
<td>“Horizontal Flip” On</td>
<td>“Horizontal Flip” On</td>
<td>“Horizontal Flip” Off</td>
</tr>
</tbody>
</table>

**Keystone**

Keystone distortion will occur when the projector and screen are on an angle (in the vertical orientation). This function is used to correct this distortion.

Select the item name “Keystone” and correct the keystone distortion using the SELECT (◀▶) buttons.

Press the ◀ button.

Press the ▶ button.

**Note:**

* The menus and other on-screen displays cannot be adjusted.
* Please note that depending on the projected picture and the projection conditions, it may not be possible to eliminate keystone distortion completely.

**Keystone Save**

This function is used to save the keystone adjustment values.

Setting Keystone Save to on will set the previous keystone adjustment values when projection after the power cable has been disconnected and then reconnected.

Select the item name “Keystone Save” and set with the SELECT (◀▶) buttons.

<table>
<thead>
<tr>
<th>Aspect</th>
<th>Auto</th>
<th>Filter</th>
<th>3</th>
<th>Vertical Flip</th>
<th>Off</th>
<th>Horizontal Flip</th>
<th>Off</th>
<th>Keystone</th>
<th>0 - +</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keystone Save</td>
<td>On</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:**

Regardless of whether Keystone Save is set to “On” or “Off”, when projection is from the standby condition, the picture is projected using the previous keystone adjustment values.
**Setup**

- Select menu name “Setup”.
  See “Menu Operation Method” on Page E-37 for information about performing menu operations. The item name display will differ depending on the input signal. See “List of Item Names Offering Input Selection and Adjustments/Settings” on Page E-42.

### Auto Source

The Auto Source function automatically detects the input signal when the power supply is switched on and when the input is switched.

Select the item name “Auto Source” and select the setting contents with the SELECT (➡️) buttons.

- On ............... Switches on the automatic detection function
- Off ............... Switches off the automatic detection function

**Signal Detection Order When On**

- The sequence of DVI → RGB → ImageViewer → Network → Video → S-Video
  - U7-137SF only

When a signal is detected, the search is stopped and the image is projected.

### Auto Power Off

This function switches off the projector power automatically when the input of the projector enters a no-signal condition.

Select item name “Auto Power Off” and select the setting contents with the SELECT (➡️) buttons.

- On ............... The power is switched off when there is no signal.
- Off ............... The power is not switched off even when there is no signal.

**Operation when Function is On**

- The “No Signal Power Off” display appears when a no-signal condition continues for approximately 10 seconds. The power is switched off about 5 minutes after this.
- If a signal is input during the appearance of the display and an operation button other than the STANDBY button is pressed, the display is closed and the function is cancelled.

**Note:**

Some video decks and other equipment output a blue background or other video when playback ends. When this happens, a signal is being input to the projector and Auto Power Off is not activated.

### Menu Position

Select item name “Menu Position” and select the setting contents with the SELECT (➡️) buttons.

- Displays on the left side
- Displays on the right side
Setup

**Lamp Mode**

Use this if the picture is projected on a small screen and the picture is too bright or when projecting images in dark rooms.

Select the item name “Lamp Mode” and select the setting contents with the SELECT (▶▼) buttons.

- **Eco** ............. The lamp brightness is set to 80% and the lamp life is extended. (STATUS indicator is green)
- **Normal** ....... The lamp brightness is set to 100% and the screen is bright. (STATUS indicator is off)

**Note:**
Frequent switching this mode can degrade the lamp.

**Input Format**

This function is used in setting the input signals of the input connectors. Normally, this should be set to Auto. When identification is not possible with Auto, make the setting.

Select the item name “Input Format”, press the ENTER button, and the submenu will open. Select the connector that is to be changed, and select the setting contents with the SELECT (▶▼) buttons.

- **[DVI]**
  - Auto ............ Automatically identifies the signal.
  - RGB ............ Analog RGB signal is set.
  - Digital ......... Digital RGB signal is set.
  - Component . Component signal is set.

- **[RGB]**
  - Auto ............ Automatically identifies the signal.
  - RGB ............ Analog RGB signal is set.
  - Component . Component signal is set.
  - (YPbPr and YCbCr signals are identified automatically.)

- **[Video] and [S-Video]**
  - “Video” is the setting of the VIDEO connector’s color format, “S-Video” the setting of the S-VIDEO connector’s color format.
  - Auto ............ Automatic identification.
  - NTSC .......... Fixed to the NTSC system.
  - NTSC 4.43 .. Fixed to the NTSC 4.43 system.
  - PAL ............. Fixed to the PAL system.
  - PAL M ......... Fixed to the PAL M system.
  - PAL N ......... Fixed to the PAL N system.
  - PAL 60 ......... Fixed to the PAL 60 system.
  - SECAM ....... Fixed to the SECAM system.

**Note:**
* When the input format has been switched, you may be required to reconnect the input signal.
* The picture may be disturbed when the input format is switched or when the mode is set back to auto. This is not a malfunction. The picture will return to normal when the input is switched, etc.
Setup

**Presentation Timer**

The presentation is given while checking the timer displayed on the screen.
The gauge display allows the remaining time to be known at a glance.

Select the item name “Presentation Timer” and select the setting contents with the SELECT ( 左右 ) buttons.

**Setting contents:** Off, 10 min., 20 min., 30 min., 40 min., 50 min., 60 min.

**To start the timer...**
Press the MENU button and open the menu.
The timer display will appear at the lower right and the timer will start.
See “Using the Presentation Timer” on Page E-30 for details.
Select menu name “Option”.
See “Menu Operation Method” on Page E-32 for information about performing menu operations. The item name display will differ depending on the input signal. See “List of Item Names Offering Input Selection and Adjustments/Settings” on Page E-42.

**Language**

This function sets the language that is displayed on screen in the messages and menu displays.

Select item name “Language” and press the ENTER button to open the Language sub menu. Select the language with the SELECT (▲▼) buttons.

<table>
<thead>
<tr>
<th>Language</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>On Screen</td>
<td>On</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Background</td>
<td>Blue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Startup Screen</td>
<td>Logo</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Security Lock</td>
<td>Disable</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network Password</td>
<td>Disable</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**On Screen**

This function switches on/off the messages displayed with a black frame such as the input signal information and the aspect ratio.

Select item name “On Screen” and select the setting contents with the SELECT (◄►) buttons.

On ............... The message is displayed.
Off ............... The message is not displayed.

**Note:**
Even when set to off, messages that are not in a black frame will be displayed.

**Background**

This function sets the screen color when the input source is no-signal.

Select item name “Background” and select the setting contents with the SELECT (◄►) buttons.

Example of a display when the FREEZE button is pressed
Option

**Startup Screen**

This is the selection of whether or not to display the logo screen at startup time.

Select item name “Startup Screen” and select the setting contents with the SELECT (►) buttons.

Logo ........... Displays the logo.
Blank ........... Does not display the logo.

**Note:**
When “Logo” is selected at the startup screen, the “PLUS” logo is displayed.

**Security Lock**

A password can be registered and the security lock set in order to prevent unauthorized use of the projector.

For instructions on using the security function, see “Protecting the Projector with the Security Lock” on E-34.

Select item name “Security Lock” and select the setting contents with the SELECT (►) buttons.

Disable ....... The security lock is disabled.
Enable ......... The security lock is enabled.

The security lock is activated when the power is turned on, and the password must be input in order to operate the projector.

**Network Password**

For details, refer to the “Image Viewer / Network” manual.
Info.

• Select menu name “Info.”.
  See “Menu Operation Method” on Page E-37 for information about performing menu operations. The item name display will
differ depending on the input signal. See “List of Item Names Offering Input Selection and Adjustments/Settings” on Page E-42.

---

Status

This displays information about the equipment.

Select item name “Status” and press the ENTER button.
There is a change to the status display.
Press the CANCEL button to return to the menu.

Display Contents:
Projector model, firmware version, and the internet home page address of PLUS Vision Corp.

---

Factory Default

This function returns the adjustments and settings of all the input sources to the standard factory default values.

Select item name “Factory Default” and press the ENTER button.
There is a change to the display [Press “ENTER” to Factory Default Set].

Press the ENTER button to initialize.
To cancel, press the CANCEL button and there will be a return to the menu.

Items that are not set to the factory default:

---

Lamp Timer Reset

This function resets the lamp timer. Be sure to perform the reset operation when the lamp cartridge has been replaced.

Select item name “Lamp Timer Reset” and press the ENTER button.
There is a change to the display “Press “ENTER” to Lamp Timer Reset”.

Press the ENTER button to initialize.
To cancel, press the CANCEL button and there will be a return to the menu.
Info.

Resolution / Frequency

This function displays the resolution and frequency of the detected input signal.

| Status       | Factory Default | Lamp Timer Reset | Resolution | 1024 x 768 | Frequency | 60 Hz, 78KHz | Lamp Timer | 1000 h |

Lamp Timer

This displays the lamp timer.

This projector has an Eco mode function. The lamp life will differ between Normal mode and Eco mode.

Lamp Life
Use only in Normal mode: approx. 2000 hours
Use only in Eco mode: approx. 3000 hours
* Lamp life will differ when there has been switching between the modes.

- **When Lamp Life Has Been Reached**
  “Replace the Lamp Cartridge” is displayed on the screen for 10 seconds in a 1-minute interval.
  Please replace the lamp with a new one.
  See “Replacing the Lamp Cartridge” on Page E-61 for information about lamp cartridge replacement.

- **When Over 100 Hours Have Elapsed Since Reaching Lamp Life (Including Eco Mode)**
  [Warning!! System Shutdown] is displayed for 10 seconds and the power is switched off. Pressing the STANDBY button under this condition will not switch on the power. Please replace the lamp cartridge.
When an Indicator is Lit or Blinking

The indicators on the projector’s control panel lit or blink to notify of problems, as described below. An indicator is also used to notify you of the currently set power mode (under normal circumstances). See “Power Cable Connections and Switching the Power On/Off” on page E-22.

<table>
<thead>
<tr>
<th>Indicator status</th>
<th>What you should do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>STATUS</strong></td>
<td><strong>STANDBY</strong></td>
</tr>
<tr>
<td>Lit red</td>
<td>When the power is on (Lit green) Standby (Lit amber)</td>
</tr>
<tr>
<td>Blinks amber for 60 seconds, then lit amber</td>
<td></td>
</tr>
<tr>
<td>Lit red</td>
<td>Blinks red (lit for 1 seconds/off for 1 seconds)</td>
</tr>
<tr>
<td>Blinks red (lit for 0.5 seconds/off for 0.5 seconds)</td>
<td></td>
</tr>
<tr>
<td>Lit amber</td>
<td>Blinks red (lit for 0.5 seconds/off for 0.5 seconds)</td>
</tr>
<tr>
<td>When the lamp has burned out during use</td>
<td>Blinks amber for 90 seconds, then lit amber</td>
</tr>
<tr>
<td>When the lamp does not come on from the start</td>
<td>Lit amber</td>
</tr>
<tr>
<td>Blinks red (lit for 1 seconds/off for 1 seconds)</td>
<td></td>
</tr>
</tbody>
</table>

Should an indicator be in a condition other than normal or flash at a rate other than the aforementioned, disconnect the power cable and contact your store of purchase.

**Thermal Protector**

When the temperature inside the projector becomes abnormally high, the STATUS indicator blinks red (0.5 seconds on/0.5 seconds off), the STANDBY indicator is a steady red, and at the same time the temperature protector operates and switches off the power of the projector.

If this happens, please take the following actions.

1. Switch off the power and disconnect the power plug from the wall outlet.
2. Check the following matters and take the required measures.

   When the projector is being used in a location that has a high ambient temperature, set it up again in a cool location. Check the outflow and intake holes and clean them if they are obstructed.

3. Wait about 60 minutes until the temperature of the projector drops.
   If after having performed the above matters, the problem still has not been solved, please contact your store of purchase.
Troubleshooting

Check the following matters before requesting servicing.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Check</th>
<th>Reference Page</th>
</tr>
</thead>
</table>
| Power does not turn on | • Is the power cord plugged into a power outlet?  
• Is the lamp cover properly mounted?  
• Is the projector's temperature high? To protect the projector, the power cannot be turned on when the projector's temperature is abnormally high.  
• Has the lamp reached the end of its service life?  
• Depending on the timing with which the power cord is plugged in (the power is turned on), it may happen that the STANDBY indicator (LED) does not light and the power does not turn on. This is not a malfunction. If this happens, unplug the power cord then plug it back in.  | E-22, E-63, E-58 |
| No image is produced | • Is a connected input selected?  
• Is the cable properly connected to the input terminal?  
• When a computer is connected, are signals being output from the computer?  
• Does the signal being input have a frequency usable with this projector?  
• Are the brightness and contrast adjusted to the minimum?  
• Is the STATUS indicator lit a steady red or blinking red?  
• When the component signal of the DVD player is connected with the DVI or RGB connector and the image is not output, is [Input Settings] of the DVI or RGB connector properly selected?  
• For a analog RGB or DVI analog input, has the picture been properly adjusted?  | E-52, E-15–21, E-65, E-44, E-58, E-52, E-44, 45 |
| Image is distorted | • Is the projector properly installed?  
• For trapezoidal (keystone) distortion, perform keystone adjustment.  | E-25, E-50 |
| Image is out of focus | • Is the lens properly focused?  
• Are the screen and projector installed at the proper distance?  
• Does the projection distance exceed the focusing range?  
• Is there condensation on the lens, etc.?  
  If the projector is moved from a cool storage area to a warm place and the power is turned on, condensation may form on the lens or internal optical parts. If this happens, wait until the condensation has evaporated before using the projector.  | E-26, E-14, E-14, — |
| Image is not in proper position and is not displayed properly | • For a computer input, are the horizontal and vertical positions properly adjusted?  
• Does the input signal have a compatible resolution and frequency? Check the computer's resolution.  | E-45, E-65 |
| Video image is crushed | • If the image is crushed in the horizontal or vertical direction or if it is not displayed over the entire screen, select a different aspect ratio.  | E-49 |
| Colors of the overall image are strange | • When inputting component signals (HDTV signals only), is “Color Space” setting correct?  
• For a composite input, is “Tint” properly adjusted?  | E-47, E-44 |
| Characters flicker or colors are offset for analog RGB inputs | • From the menu, select “Image” and adjust the “Picture Adj.” and “Fine Picture”.  | E-44, 45 |
| Cannot select the menu name | • Other than [Setup], [Option] and [Info], selection will not be possible unless a signal is being input to the projector and the image/picture is projected.  | — |
| Remote control unit does not operate | • Are the remote control unit’s batteries worn? Replace with new batteries.  
• Is there an obstacle between the remote control unit and the projector’s remote control signal sensor?  
• Is the remote control unit outside of range?  
• Are you pointing the remote control unit's transmitter towards the projector's remote control signal sensor?  | E-12, E-12, E-12, E-12 |
| STATUS indicator is lit red or blinking red | • See “When an indicator is lit or blinking”.  | E-58 |
Cleaning

• Be certain to disconnect the power plug from the power outlet before cleaning.
• Do not spray or otherwise expose the projector, lens, or screen to volatile substances such as insecticides. Do not leave rubber or vinyl products in contact with the projector for long periods. Doing so could cause them to undergo qualitative changes or the coatings may peel, etc.

Cleaning a Soiled Projector Main Unit
• Wipe with a lint-free, soft, dry cloth.
  When very dirty, wipe with a cloth that has been moistened with a diluted neutral detergent, then finish with a dry cloth. If a chemically-treated cloth is going to be used, please follow any written warnings.
• Do not wipe with thinner, benzene, or other solvents. Doing so could cause them to undergo qualitative changes or the coatings may peel, etc.
• When removing the dust of the outflow and intake holes, use the brush attachment on a vacuum cleaner to clean out the dust. Avoid using the vacuum directly without attaching the adapter as well as the use of a nozzle adapter.
• Do not scratch or otherwise hit the projector body with your nails or other hard object, since this will cause scratches.

Dirty Lens
• Clean using the same method you would use to clean a camera lens: Use a commercial blower for camera use or cleaning paper for eye glasses. Be careful not to scratch the lens at this time.

Dust of the Intake and Outflow Holes
Dust that collects in the intake and outflow holes will obstruct the ventilation and cause the internal temperature to rise which could cause damage. Clean this area carefully. As a guideline, clean at least every 100 hours of usage.

• Switch off the power, check that the STANDBY indicator has changed to a steadily lit amber, then unplug the power cable.
• Clean out the holes from the outside using a vacuum cleaner. Use the brush adapter of the vacuum cleaner to do this. Avoid using the vacuum directly without attaching the adapter as well as the use of a nozzle adapter.

Cleaning the Inside of the Projector
Cleaning of the inside of the projector is required about once a year. Failure to clean over a long period while dust has collected inside the projector could cause a fire or breakdown. Do not clean the inside of the projector by yourself. Please be sure to contact your dealer.
Replacing the Lamp Cartridge

- The lamp that is used as a light source in the projector has a limited service life. The rated service life of the lamp is about 2000 hours (when used in normal mode only). This could be shortened depending on conditions of use and other factors. Note that lamp life will be extended when the projector is often used in Eco mode. (The rated service life of the lamp means the average value of lamp life for lamps that have been manufactured over a long period, and it is derived from test conditions at this company.)
- When the life of the lamp is exceeded, the STATUS indicator lights a steady red and the message [Replace the Lamp Cartridge] is displayed on the screen. When this occurs, it is time to replace the lamp cartridge. Please make the replacement following the procedure below.
- If the projector is used another 100 hours after the lamp’s service life is reached, the power is set to the standby mode and no longer turns on.
- Contact a store that sells the U7-132SF/U7-132hSF/U7-137SF for a replacement lamp. Indicate you need a U7-300 replacement lamp for the U7-132SF/U7-132hSF/U7-137SF (order code 28-057).

⚠️ CAUTION

- Replacement of the lamp cartridge is performed after switching off the power, waiting for the cooling fan to stop, disconnecting the power plug from the power outlet, and then leaving the projector for about 60 minutes before replacement is started. Replacement of the lamp cartridge during operation or immediately after operation stops will cause burns because of the high temperature.
- Do not remove any screws other than those specified.
- Do not touch the lamp with bare hands. Doing so could shorten the life of the lamp.
- If lamp has reached the end of its usable life, the lamp bulb may shatter. When this happens, an explosive sound can be heard and pieces of glass may be scattered in the lamp cartridge. Do not touch them as the pieces of glass may cause injury. If this happens, contact your dealer or the store the projector was purchased.
Replacing the Lamp Cartridge

1 Unplug the power cord.

2 Remove the lamp cover.
   (1) Turn the lamp cover’s set screw counterclockwise and loosen until the screw turns freely. (The screw does not come off.)
   (2) Open the lamp cover a little, then pull it in the direction of the arrow and remove it.

3 Remove the lamp cartridge.
   (1) Turn the lamp cartridge’s two set screws counterclockwise and loosen them until the screws turn freely. (The screws do not come off.)
   (2) Grasp the lamp cartridge’s handle and pull upward to remove the lamp cartridge.
Replacing the Lamp Cartridge

4 Mount the new lamp cartridge.

(1) Place the lamp cartridge with its socket facing to the left and push it in slowly.
   (Line it up with the screw holes in the projector.)

(2) Turn the two lamp cartridge screws clockwise to tighten them.

5 Mount the lamp cover.

(1) Set the tip of the lamp cover in place, then close the lamp cover.

(2) Turn the lamp cover’s screw clockwise to tighten it.

6 Reset the Lamp Timer.

   Connect the power cable, switch on the power, and then reset.

   Select “Info.” → “Lamp Timer Reset” on the menu and press the ENTER button. There is a change to the initialization verification display. Press the ENTER button again. See “Lamp Timer Reset” on Page E-56.

Note:
After reaching the lamp service life, if the lamp is used for more than another 100 hours, it will not be possible to switch on the power. Should this happen, while the projector is in the standby mode, simultaneously holding down the projector’s SOURCE button and AUTO button for more than 5 seconds will clear the lamp timer. Checking that the STATUS indicator is out will show that the lamp timer has been cleared.

Contact a store that sells the U7-132SF/U7-132hSF/U7-137SF for a replacement lamp. Indicate you need a U7-300 replacement lamp for the U7-132SF/U7-132hSF/U7-137SF (order code 28-057).
Specifications

Model U7-132SF/U7-132hSF/U7-137SF

Optical
Method of projection : DLP™ (single chip DMD)
DMD 0.7 inches 1024 × 768 dots
Lamp 300 W high pressure mercury lamp
Projection lens : Manual zoom ( × 1.2), Manual focus F = 2.6 – 2.8, f = 22.1 – 25.6 mm
Image size Minimum 34 inch (at projection distance of 1.20 m / 3.9 feet telephoto)
Maximum 300 inch (at projection distance of 9.47 m / 31.1 feet wide)
Light Output U7-132SF :
3000 lumens (in the “Dynamic” mode)
U7-132hSF / U7-137SF :
3500 lumens (in the “Dynamic” mode)
Contrast Ratio 2000:1 (Full on/off)

Electrical
Inputs Video (NTSC3.58/NTSC4.43/PAL/PAL-N/PAL-M/PAL60/SECAM)
RGB (Horizontal : 15 to 80 kHz, Vertical : 50 to 85 Hz)
Projector control U7-132SF / U7-132hSF :
RS-232C
U7-137SF :
RS-232C or Telnet via a LAN (using PLUS projector control commands)
Color Reproduction Full color (16,770,000 colors)
Resolution VGA (640 × 480) expansion/true, S-VGA (800 × 600) expansion/true
XGA (1024 × 768) true, S-XGA (1280 × 1024) compression
Input Current 4.3 A
Power Requirement 100 - 240 V AC, 50/60 Hz
Power Consumption 430 watts (380 watts in eco mode)

Mechanical
Dimensions Excluding Stand 258 mm (W) × 83 mm (H) × 320 mm (D)
10.2 in. (W) × 2.9 in. (H) × 12.6 in. (D)
Weight U7-132SF / U7-132hSF :
3.0 kg / 6.6 lbs
U7-137SF :
3.1 kg / 6.8 lbs
Operational Temperatures Data projector: 5° to 35°C (41° to 95°F), 30 to 85% humidity

• Specifications and design are subject to change without notice.

Discount-Merchant.com (800) 281-8860
THE TRUSTED SOURCE FOR PROJECTOR LAMPS AND ACCESSORIES

E-64
## Table of Supported Frequencies

The projector automatically identifies the signal input from the computer and selects the optimum resolution as shown on the table below.

Manual adjustments may be required for some input signals. See “Picture Adj. / Fine Picture / H Position / V Position” on page E-44, 45.

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution</th>
<th>Frequency</th>
<th>Video</th>
<th>Component</th>
<th>Digital</th>
<th>Analog</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Horizontal (kHz)</td>
<td>Vertical (Hz)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIDEO(NTSC)</td>
<td>–</td>
<td>15.734</td>
<td>60.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIDEO(PAL/SECAM)</td>
<td>–</td>
<td>15.625</td>
<td>50.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PC/AT</td>
<td>640 × 350</td>
<td>31.5</td>
<td>70.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>640 × 400</td>
<td>31.5</td>
<td>70.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>720 × 350</td>
<td>31.5</td>
<td>70.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>720 × 400</td>
<td>31.5</td>
<td>70.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA</td>
<td>640 × 350</td>
<td>37.9</td>
<td>85.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>640 × 400</td>
<td>37.9</td>
<td>85.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>720 × 400</td>
<td>37.9</td>
<td>85.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>640 × 480</td>
<td>31.5</td>
<td>60.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>640 × 480</td>
<td>37.9</td>
<td>72.8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>800 × 600</td>
<td>43.3</td>
<td>85.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>800 × 600</td>
<td>35.2</td>
<td>56.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>800 × 600</td>
<td>37.9</td>
<td>60.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>800 × 600</td>
<td>46.9</td>
<td>75.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>800 × 600</td>
<td>48.1</td>
<td>72.2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>800 × 600</td>
<td>53.7</td>
<td>85.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1024 × 768</td>
<td>48.4</td>
<td>60.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1024 × 768</td>
<td>56.5</td>
<td>70.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1024 × 768</td>
<td>60.0</td>
<td>75.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1024 × 768</td>
<td>68.7</td>
<td>85.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1280 × 1024</td>
<td>64.0</td>
<td>60.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Apple Macintosh</td>
<td>640 × 480</td>
<td>35.0</td>
<td>66.7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>823 × 624</td>
<td>49.7</td>
<td>74.5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1024 × 768</td>
<td>60.2</td>
<td>74.9</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1152 × 870</td>
<td>68.7</td>
<td>75.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDTV (1080p)</td>
<td>1920 × 1080</td>
<td>33.8</td>
<td>60.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1920 × 1080</td>
<td>28.1</td>
<td>50.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1280 × 720</td>
<td>45.0</td>
<td>60.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDTV (576p)</td>
<td>720 × 576</td>
<td>31.3</td>
<td>50.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>720 × 480</td>
<td>31.5</td>
<td>60.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SDTV (576i)</td>
<td>720 × 576</td>
<td>31.3</td>
<td>50.0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>720 × 480</td>
<td>31.5</td>
<td>60.0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The projector does not support the ADC connector on Apple Macintosh.

○ : Supported frequency
– : Not supported frequency

The display resolution is 1024 × 768 dots. When displaying a signal with resolutions other than 1024 × 768 dots such as 1280 × 1024, sizes of characters or lines may be uneven.
Cabinet Dimensions

Unit: mm (inch)

258 (10.2)
83 (3.3)
320 (12.6)
Disclaimer

This user manual is provided as a free service by FixYourDLP.com. FixYourDLP is in no way responsible for the content of this manual, nor do we guarantee its accuracy. FixYourDLP does not make any claim of copyright and all copyrights remain the property of their respective owners.

About FixYourDLP.com
FixYourDLP.com (http://www.fyxoyurdlp.com) is the World’s #1 resource for media product news, reviews, do-it-yourself guides, and manuals.

Informational Blog:  http://www.fyxoyurdlp.com
Video Guides:    http://www.fyxoyurdlp.com/guides
User Forums:    http://www.fyxoyurdlp.com/forum

FixYourDLP’s Fight Against Counterfeit Lamps:
http://www.fyxoyurdlp.com/counterfeits

Sponsors:

RecycleYourLamp.org – Free lamp recycling services for used lamps:
http://www.recycleyourlamp.org

Lamp Research - The trusted 3rd party lamp research company:
http://www.lampresearch.com

Discount-Merchant.com – The worlds largest lamp distributor:
http://www.discount-merchant.com